
 
 

Further Dreamweaver CS5 Discussion 
 
Audience and Project Requirements 
 
Identify the purpose, audience, and audience needs for website content 
 
Before you start any Website project, it will help to analyze your client’s and 
your end user’s needs to determine the project’s objectives. These objectives are 
essential to shape the right design, find appropriate solutions, and keep a project 
on track. Be sure to document your findings and have them accessible to anyone 
working on the project because sometimes the most obvious, important 
objectives are easily overlooked in the hustle of a project pipeline. You should 
speak with the client and discuss the following questions: 
 

 • What is the purpose of the project? Evaluate the client’s 
goals for the project to see how the website design and content can best 
serve their purposes. Will the content be educational, entertaining or 
informational? What kinds of media formats do they wish to include? What 
functionality is required to accomplish their goals? What level of 
interactivity do they want to offer their users?  

 
 • Who is the target audience? Defining target 
demographics is important in determining how best to communicate a 
website’s content. Key demographics can include (but are not limited to) 
age group, gender, level of computer literacy, education, wealth bracket 
and geographical location. Demographics will vary from project to project. 

 
 • What are the audience’s needs? Imagine yourself in your 
audience’s shoes: what do you think they want from your website, and 
how can you best deliver that experience to them? Factors such as 
usability, level of engagement, accessibility, time commitment, and 
required technology are all examples of how a user’s needs will have to be 
addressed to shape the best experience for them. 

 
Identify website content that is relevant to the device on which it will be 
used 
 
Having a clear idea of which platform or the types of devices your content will be 
delivered across will have a major impact on the design and development phases 
of the project. Based on whether your website is a desktop application, 
mobile/tablet site or kiosk, the content will have to be organized and delivered 
differently. Examples of the types of considerations you’ll encounter are screen 
size, touch screen versus mouse interactivity, internet bandwidth, simple versus 



complex navigation/functionality, etc. You’ve probably noticed a difference in 
website design on mobile devices; this is because they optimize (or limit) their 
functionality for the smaller screen size.  
 
 
 
Establish criteria for determining whether content is relevant 
to the purpose 
 
It’s tempting when adding content to your website to pull out all the tricks to 
attract and impress an audience—after all, attention spans have decreased in the 
fast-paced digital age. However, if you truly wish to engage your audience the 
best advice is don’t waste their time. Superfluous information, bells and whistles 
are distracting and should be avoided.  
 
To accomplish this, evaluate all content to make sure it has meaningful value to 
the target audience. If your site is informational, make sure that your content is 
easy for visitors to understand. It is better to keep things simple, short and to 
the point rather than overwhelm a visitor, possibly confuse them, or even lose 
their interest all together.  
 

Accessible Website Content 
 
Understand options for producing accessible website content 
 
Website Standards or Checkpoints were created to ensure that website content is 
accessible to the disabled.  The Web Content Accessibility Guidelines are based 
on 4 principles: Perceivable, Operable, Understandable and Robust, otherwise 
known as the POUR principles.  You can find out more about the POUR Principles 
at the W3C site http://www.w3.org/WAI/WCAG20/quickref/ 
 
Accessibility in the target audience 
 
When creating website content it is crucial to consider all types of people who 
may make up the target audience. Many people with visual, auditory, mobility 
and other disabilities have difficulties accessing various aspects of content and 
use assistive technology to aid them in navigating websites and applications. By 
making content accessible you are helping your client reach more people and 
ensures that no member of the target audience has to endure additional 
frustration or is left out of the experience. 
 
Screen Readers and the Accessibility Panel  
 
Adobe Dreamweaver CS5 has made it easier for you to create accessible Website 
content. By using the Accessibility Panel (found under the Window drop-down 
menu, under the Preferences Dialog Box) you can make content readily available 
for screen readers to interpret for people with visual impairment. Screen reader 
software such as JAWS, Windows-Eye and Yahoo Asteroid Toolkit will read 
the content on web pages out loud for the user, and the person can also use 



keyboard shortcuts and the “tab” key to browse screen information faster and 
more selectively.   
 
To select accessibility preferences, click Edit on the Application bar (WIN) or 
Dreamweaver on the Menu Bar (Mac), click Preferences and then click the 
Accessibility category. 
 
 
 
Other Accessibility Considerations 
 
There are some easy steps you can take to making your content more accessible 
while still in the design stage.  Consider different types of color vision deficiency 
when selecting your color scheme and never rely on color alone to express 
information. Also, many elderly people have trouble reading small font sizes. 
Keeping the fonts at a more legible size, or at least having options for making 
the fonts larger, are both good ideas. For the visually impaired you should 
always allow for user control of audio and video; building on this you can 
increase accessibility by giving keyboard shortcuts to playback controls. For 
people who are deaf or hard of hearing you can easily add closed captioning at 
cue points in your video or provide the text equivalent of audio clips.  
 
Through the development process (and certainly before your project launches) 
you should validate for accessibility by navigating the content with different 
screen readers and by having people with diverse impairments perform quality 
assurance testing. By taking these measures you ensure that your efforts result 
in website content that is thoroughly accessible. 
 
 
 

Copyrights 
 
Demonstrate knowledge of standard copyright rules (related 
terms, obtaining permission, and citing copyrighted material)  
 
First review the following terms: 
 
Intellectual Property – can be any original work in the form of a design, text, 
photo, video, sound, logo, name or innovation that is used commercially or as a 
form of expression.  
 
Copyrighted – the copyright law protects the ownership of intellectual property 
once it has been created in a fixed medium with or without applying for a federal 
copyright. In order to reuse or reproduce copyrighted property that is not yours 
written permission must be obtained from the creator or owner. Many cases of 
obtaining permission will also include paying royalties. Whenever you see 
“copyright” or the © symbol, author name and/or published date that work falls 
under copyright protection. It is safe to assume any work you see, hear or read 
is copyrighted unless it comes with a statement that that you may reproduce it 



without permission from the author/owner. 
 
Fair Use Doctrine – this creates a loophole in the copyright law whereby 
copyrighted material can be reused in part as long as it falls under the guidelines 
of “fair use”. These “fair use” guidelines loosely stand to help the flow of 
information to the public as long as the usage is not at too great of a conflict to 
the original work. Usually educational purposes fall under ”fair use”. 
 
Derivative Work - is a new product that includes an aspect of a previously 
copyrighted work. 
 
Citing online copyrighted material: 
When reusing a copyrighted work under the Fair Use Doctrine you should always 
cite the original material. For video, audio, text, images and websites found 
online you should always cite the creator(s), the title, the creation date, the URL 
and a brief description may also be necessary.  
 

Project Management 
 
Understand project management tasks and responsibilities 
 
The Project Plan 
 
A project plan is a list of guidelines to follow to control and execute a project 
from start to finish. These guidelines define the project scope, including details 
of project specifications, internal due dates for the completion of specific tasks, 
milestones for project deliverables, a client approval process, and a project 
timeline. Possible deliverables for a web site may include sketches, wireframes, 
mockup designs, interaction/animation storyboards, site map structure and 
prototypes. The project plan also details resource allocation, which indicates 
which tasks go to which team members.  
 
Scope creep (or feature creep) is the expanding of work beyond the original 
project plan, and it happens on just about every project. The effects of creep can 
have a devastating impact on everyone’s time and the client’s expectations. 
Therefore the project plan should contain some “padding” to allow for the 
shifting of internal due dates, so that critical tasks are not held up by other tasks 
taking too long. Examining a project’s structure, breaking it down into detailed 
tasks, and assessing which tasks may encounter complications are all essential 
steps. As always, timely communications between team members and the client 
are a key factor in the project’s success. 
  
The phases of the project plan are: 
 
Analysis and Planning - The first step where client goals and target audience 
considerations are established and initial project planning begins. 
 
Design – A plan starts to take visual form in style guides, color schemes, 
wireframes, graphics and design mockups. 



 
Building/development – Prototypes are built that include the structure, 
interactivity and functionality for the website content. Graphics are also 
integrated. 
 
Testing – Thorough quality assurance testing is performed to uncover bugs, 
usability issues or other possible errors and report them to the design and 
development team for revision.  
 
Implementation/Launch – A project is in its final stage, the bugs are 
squashed and the client has approved it to launch. You’re ready to “go live” and 
make the web site available to the public. 
 

Website Design Elements 
 
Benefits of consistency 
 
With the wide range of creative freedom Dreamweaver extends to designers and 
developers it can be tempting to try to impress a client with a unique approach 
they’ve never seen before. However it is important to remember that the most 
import aspect of an interface is that it functions well for the target audience. 
Design conventions such as links that look like buttons, identical navigation 
across all pages and icons that clue the user into the content help create 
consistency that users can follow based on their past experiences. Sticking to 
design conventions and keeping the end user in mind will provide a level of 
comfort to the end user, and even save you time in the design/development 
process. 
 
Web-safe colors 
 
While not the problem that it used to be, with the availability of so many 
different computers and browsers—both old and new—there can be a wide 
variance in how designs appear onscreen. Web-safe colors were adopted to tame 
the effects of this, and can be used to create a consistent appearance. In 
Dreamweaver you have the freedom to pick any color. If you are relatively 
certain that your target audience will be using new, consistent browsers/devices 
to navigate your site, you probably don’t need to worry too much about this. But 
if you think your customers may include older machines and older browsers you 
should consider using web-safe colors for critical elements. 
 
Identify criteria for using engaging website content  
 
You can keep a user’s interest with informative animation and transitions to 
illustrate progression and visual hierarchy. Audio and video files can be easily 
implemented to display consistently across browsers and computers with 
consistent skins and controls. Screen real estate can be saved from content 
overload by organizing navigation into dropdown menus or layering information 
into one dynamic area of the screen. This is where you can get really creative—
the possibilities are endless. 
 



Always consider the operating system and web browser in website 
design 
 
Today’s internet users have a variety of operating systems and web browsers to 
choose from. Windows, Mac (including iOS) and Linux are the most common 
operating systems.  Internet Explorer, Safari, Firefox and Chrome are the most 
popular web browsers.  When designing and developing your website you must 
always consider the fact that not everyone uses the same operating system or 
web browser.   
 
Fonts are the not available on some operating systems.  Dreamweaver supports 
an inventory of fonts that work on both Windows and Mac operating systems.  
The fonts are listed in preferential order for displaying the text.  If one font is not 
available then the next one on the list is displayed. The last font on the list is a 
generic font that is supported by all operating systems. 
 
NOTE: A recent positive development in web typography is the proliferation of 
free-open-source fonts from providers such as Google Fonts. You can embed 
these fonts in your web site, they are supported by all modern browsers, and 
add a tremendous amount of design flexibility to your web designs. You can find 
out more at: http://www.google.com/webfonts#HomePlace:home  
 
Web browsers also need to be considered in the web site design.  In 1990 a list 
of 216 Browser/Web safe colors was developed and is supported and displayed 
by Dreamweaver.  This list of Browser/Web safe colors somewhat limits design 
but guarantees that your color choices will appear as you designed them on any 
web browser (although as previously noted, if your site is intended for users who 
are up-to-date with their devices and browsers, web-safe color is not the issue 
that it used to be). 
 
Other Web Browser considerations when designing your website are tables, 
margins and horizontal lines. The Wikipedia article on the history of web 
browsers is dense, but it may prove useful when determining whether a feature 
you need is compatible all of the browsers you hope to support: 
http://en.wikipedia.org/wiki/Comparison_of_web_browsers 
 
Page Layout, Graphic Design Elements and Principles  
 
Before you start your website project it is beneficial to have a good grasp of 
Page layout graphic design elements and principles.  Lines, shapes, images and 
textures are all design elements. Alignment, balance, color, contrast, emphasis, 
movement, proximity, repetition, rule of thirds, symmetry, unity and whitespace 
are all Principles of Design. 
 
Design Elements 
 
Lines - can be dashed or dotted, horizontal, vertical, or diagonal , long or short, 
thick or thin, straight or wavy—and are the foundation of every shape. 
 
Shapes – consist of connected lines and can be geometric or organic. 



 
Texture – the surface or fill of a shape that describes the “feel” of the object. 
 
Design Principles 
 
Alignment – spacing of shapes or words relative to the page and each other. 
 
Balance – the elements on a page are organized and distributed in a pleasant 
manner that encourages the visitor to look around and explore. 
 
Color – can affect the behavior of the viewer and can evoke an emotion or a 
positive or negative reaction. 
 
Contrast – creates differences for effective comparison of elements. 
 
Emphasis – similar to contrast, making an element stand out. 
 
Movement – add a sense of direction using dotted lines or arrows. 
 
Proximity – the distances of words and objects can indicate a connection (or a 
lack of one). 
 
Repetition –create a feeling of consistency or mapping; repeating a similar layout 
on every page gives the viewer a sense of familiarity. 
 
Rule of Thirds – the theory that the most visually interesting component of a 
page is not in the exact center, but rather is positioned a third of the way in from 
an edge or corner. 
 
Symmetry – the even distribution of text and objects around the center point (or 
vertical line) on a page.  Symmetry is one way to achieve balance on a site. 
Similarly, carefully-chosen asymmetry can be used to emphasize an element on 
a page. Symmetry can be diagonal, horizontal, radial or vertical. Diagonal 
symmetry balances objects along an invisible diagonal line on the page, 
horizontal symmetry refers to elements that are evenly distributed/balanced 
across the pages, radial symmetry means the distribution/balance is from the 
center of the page outward, and vertical symmetry is when the 
distribution/balance is down the page.  Asymmetric symmetry is when objects of 
varying sizes are distributed around the center of the page.  Smaller shapes are 
placed with larger shapes to balance the page. 
 
Unity – the principle that brings everything together (the entire site is one). 
 
White Space – empty spaces on the page including line spacing and margins. 
Effective use of white space be the primary difference between a site that looks 
well-designed and a site that looks cluttered. 
 
All websites need to have a layout that applies the principles of design. Creating 
a website layout that does not adhere to the basic principles of design will not 
contribute to increased traffic to your site. The purpose of most websites is to 



have people visit… preferably multiple times. Poor color choices or 
inconsistencies will turn people off, and they may never come back to the site or 
refer the site to someone else. 
 
Website Accessibility, Readability and Usability Principals  
 
Sound, links, movies and graphic elements are typically unreadable by screen 
readers.  Dreamweaver allows you to use specific tools that make unreadable 
elements readable to viewers with disabilities or motor impairments.  These 
elements can be viewed or realized utilizing an alternate text tag in 
Dreamweaver. The alternate text will be read when the otherwise unreadable 
element is encountered.  
 
In Dreamweaver if you want to provide alternate text for an image you’ll use the 
Polygon Hotspot Tool.  Once your image is loaded, click on it, and in the 
Property Inspector you’ll see the selected image and the Polygon Hotspot Tool.  
If you select the Polygon Hotspot Tool and click on the Hotspot area of your 
image a Dreamweaver dialog box will appear and ask you to write a description 
of your element. Once you are satisfied with your description, click OK. Next 
draw a Hotspot on your image. In the Property inspector click the Alt text box, 
then type the additional information you wish to be displayed. 
 
Creating alternate text or keyboard accessibility for links in Dreamweaver is also 
possible.  From the menu choose Insert -> Hyperlink.  In the resulting dialog box 
note that you can add a Tab index number and Access key to allow your user 
to activate the link with only keyboard strokes. 
 
To improve website usability the there are some important fundamentals or 
guidelines to follow.  If the website is not user friendly then you will not keep site 
visitors and they certainly will not return to your site.  The following tips can help 
make your website user friendly: 
 

 • Make sure the purpose of the site is clear to the visitor. 
 • Use legible, varying font sizes, combined with contrasting 
colors. 
 • Headings and drop down menus must be obvious and 
descriptive. 
 • Locate important information at the top of the page. 
 • Use a consistent layout to quickly familiarize the visitor to 
function and structure. 
 • Use Graphics and Tables to emphasize and organize specific 
items. 

 
There are also some text formatting guidelines that make a website more 
readable.  Styling text with CSS is preferable to creating text as an image.  Using 
CSS makes the text more accessible to reading mechanisms, assistive 
technologies and more flexible for the end user to manipulate with color or size.   
 
Designate a generic font, which will be displayed if your chosen “designer” font is 
not present.  Dreamweaver has 4 default generic fonts: sans serif, serif, mono-



space, and cursive. Be sure to test your site with the generic fonts to make sure 
everything remains legible and your layout is preserved. 
 
CSS should also be used when alignment, spacing, indentations, paragraph 
format and control of text are a critical component of a website design.  Use of 
CSS in text placement and alignment makes the site more accessible to reading 
mechanisms and assistive technologies. The order of text in tables is also 
important, because many reading mechanisms and assistive technologies read 
the HTML code in the order written… which may not necessarily be the order the 
text is displayed in the table. If you ensure that the text in your HTML code is in 
the same order it appears in a table, your website will be more accessible to 
these assistive technologies. 
 
Dreamweaver’s Workspace Switcher 
 
Dreamweaver allows you to customize your workspace to suit your needs. 
You can reset your workspace to default settings, switch to other workspaces or 
create a custom workspace using Dreamweaver’s Workspace Switcher. The 
default workspace in Dreamweaver is Designer. You can customize workspaces 
and save them by clicking on New Workspace from the Workspace Switcher 
menu, or use the Window menu to access workspaces on the Workspace 
Layout menu. 
 
 
The Insert Panel in Dreamweaver 
 
The Insert Panel/Bar is used to create objects or insert objects from other 
programs into Dreamweaver. The Insert Panel buttons are organized by 
categories. “Common” is the default category, and has a menu that allows you to 
access additional buttons and menus for the category. The same functions exist 
for the other categories in the Insert Panel/Bar. You can view the categories as 
tabs or menus. To view them as menus right click a tab on the Insert toolbar and 
then click “Show as Menu”. 
 
The Assets Panel in Dreamweaver 
 
The Assets Panel is used to organize your inventory of files, images, graphics, 
sounds, video, Flash elements and templates that you will be using on your 
website project. Assets in the Asset Panel can be viewed in two different 
categories.  The two categories are the Site list, which contains all of your 
assets, and the Favorites list which contains the assets which you have 
designated as the most important. Once you have defined an asset for a specific 
project, it will appear in the Assets Panel. 
 
To insert an item from the Assets Panel place an insertion point on your website, 
select an asset either from the Site list or the Favorites list and click Insert on 
the bottom of the Assets Panel.  Type a description of the asset in the Image Tag 
Accessibility Attributes dialog box and then click OK to place the image at the 
insertion point.   
 



Don’t forget to save your work! 
 
Naming Your Website 
To create a new page in Dreamweaver you can use the File menu or the Start 
page. You should use either default.htm(l) or index.htm(l) as the name of your 
homepage (web-servers will recognize these pages as the main page of the 
website). Asset, file and folder names should start with a letter and only be one 
lowercase, alphanumeric word that is no more than 10 characters long. An 
underscore ( _ ) or hyphen ( - ) are the only non-alphanumeric 
characters that are allowed. It is suggested that you use a hyphen when 
possible because an underscore can be hard to see. File extensions  that you 
should use for your webpage are as follows: .html, .htm .shtml, .shtm, .stm, 
.tpl, .lasso, .xhtml. 
 
 
The Uniform Resource Locator (URL) is the internet address for the website.  
Web page file names, folders and assets are included in the address, and each is 
unique. 
Folders are designated by a preceding and following forward slash ( / ). Because 
of this, a forward slash cannot be used in the name of a file or folder. 
 
The Title of the page appears in the title bar, and is not the same thing as the 
url (address) of the page. Dreamweaver allows you to define the title in the 
Page Properties or in the Title Text box on the Document toolbar.  The Page 
Properties dialog box is located inside the Property inspector. 
 
Adding Text to your Website 
 
If you can use Word or any other word processing software you can add text to 
your website.  Either type text directly into the page or copy/cut and paste text 
from another source such as Word, Excel, Pages, TextEdit, WordPad, or any .txt 
files or .xml files. 
 
Image/Graphic File Types  
 
The three most commonly used image file types are JPEG (.jpg), GIF (.gif), and 
PNG (.png).  Use of these file type almost guarantees your website images will 
be viewable from any modern browser (PNG may not be viewable in older 
browser versions).  .aif, tiff, eps, pdf, png, and bmp files should be avoided 
when developing your web pages (although these can be linked/embedded if you 
want your visitors to be able to download a high-quality version of an image or 
document). 
 
Adobe InContext Editing 
 
InContext Editing enables designers to create, manage, and control editable web 
pages and is an online service offered by Adobe. By using InContext Editing, web 
designers can now allow content editors and publishers to manipulate website 
content through web browsers without compromising design integrity, having to 
know HTML, or downloading software. 



 
Inserting Fireworks-created Images, Buttons and Navigation Bars 
 
If you are creating your site in Dreamweaver you should know that you can 
export navigation bars, rollover images, and buttons created in Fireworks.  
Select HTML and images as the export type in Fireworks.  Then in Dreamweaver, 
insert the object by clicking Rollover Image, Image Placeholder or 
Fireworks HTML (depending on your item). The Insert Rollover Image dialog 
box allows you to enter alternate text, select both the original and the rollover 
images, and create a link. 
 
Adding Excel or Word to your Dreamweaver Website 
 
To insert an Excel or Word document in a new web page click the Import 
command in the File menu and select either “Excel” or “Word”.  Dreamweaver 
has five import options: 
  

 • Text Only - No formatting. 
 • Text with Structure – Paragraphs, tables, and list (font 
features not supported). 
 • Text Structure with Basic Formatting – some formatting is 
maintained. 
 • Text Structure Full Formatting – all formatting is maintained. 
 • Clean up Word Paragraph Spacing – removes spacing   

 
Dreamweaver also allows you to link to an Excel or Word document to your 
Webpage.  To do so drag your document to the location where you want the link.  
Open the Insert Document dialog box and select whether to insert the document 
or create a link.  You will need to make sure the document is located in the site’s 
root folder. When the document is in the root folder Dreamweaver makes it 
available when the website is published.  The link text is the name of the linked 
file, which you can edit if desired. 
 
Modifying Text Properties 
 
Some web browsers read only a limited number of fonts. It is necessary to 
assign a font family. Font families are a list of alternate fonts, which are enabled 
when your original font is not available in a given browser. 
 
Text entered into a Dreamweaver document is set to a default font. To change 
the default font use the Property Inspector and select CSS. Dreamweaver 
provides a few default font families. You can create your own font family by 
selecting the Font pop-up menu and clicking on Edit Font List. 
 
Modifying Image Properties in Dreamweaver  
 
You can modify Images right in Dreamweaver.  Using the Image Property 
inspector there are common image manipulation tools.  Using these tools will 
permanently change the image, so make sure to keep a backup of your original 



source image. Dreamweaver has the following image editing tools: 
 

 • Brightness and Contrast 
 • Cropping 
 • Sharpen 
 • Re-sampling – changes the number of pixels that make up 
the image 
 • Edit Image Settings – adjusts the appearance of the image. 

 
Scaling an image is easy in Dreamweaver.  Select the Edit Image Settings button 
in Property Inspector.  This opens the Image Preview dialog box.  Select the File 
tab and you can easily scale or resize the image for the page. 
 
In Dreamweaver you can Round Trip Edit website assets that are in other Adobe 
applications like Photoshop, Flash or Fireworks, as long as these applications are 
installed on your machine.  To open the image in these applications select the 
image, then the Image Property inspector. In the program select Edit and you 
can now adjust the asset in your chosen editor.  
 
 
How to Add Head Content  
 
Click the Head button on the Common category of the Insert Panel to edit or add 
content to the base, link and meta tags.  You can also add keywords and a meta 
tag description. 
 
Click Insert on the Application bar (Win) or Menu bar (Mac), point to HTML, 
click Head Tags, and then click Description and a dialog box will open.  Enter 
the text for the description. 
 
Evaluating and Maintaining a Site Using Dreamweaver 
 
Spell Check 
You can check the spelling of a webpage by selecting Check Spelling  
in the Commands menu.  Dreamweaver will find all unrecognizable words from 
the dictionary you select (from multiple language dictionaries).  You can add 
words, correct a word yourself, or Dreamweaver will suggest the correct spelling 
of a word.   
 
Browser Preview 
Dreamweaver allows you to preview your website in several browsers before you 
publish. You can preview the browsers you have installed on your PC or Mac or 
you can use the Adobe BrowserLab. Click File and select Preview in browser, 
select a browser installed on your computer, and then click a preview option. 
 
You can also use the Adobe BrowserLab, one of the CS live online services, to 
preview browsers not on your computer. To open ABL select Extensions on the 
Window menu and open Adobe BrowserLab.  
 
Tip: The storyboard you created before you started the website represents what 



you and/or your client wanted the site to be. Previewing a site is a good time to 
look back at your storyboard to make sure your site reflects what you originally 
planned.  
 
Basic Usability Tests 
You should verify how well your site functions by conducting a usability test. 
Checklist or scripts need to be created to determine what will be measured. You 
will need a control group of people to review your website against the 
checklist/script. The results of their review will determine the usability of your 
site. Usability.gov (a federal entity) offers a guide to the process. There are 
many usability test templates available in the public domain. 
 
Visitor Feedback 
Once your site is published you should begin to get viewer feedback about the 
form and function of your site. There are many different ways for you to get 
feedback from visitors, but one of the most common is the use of surveys. You 
can have a pop up survey appear on specific pages, or you can ask for 
participation and e-mail a survey to a participant. You an create a feedback link 
that, when selected, opens up a form or the users e-mail client requesting 
feedback. There are services available that will monitor and request information 
from your visitors. There are also services available that can monitor visitor 
behavior on your website. 
 
Focus groups are a traditional marketing method used to trial offline products 
and services. Assembling a focus group to evaluate your website before and 
after you publish your site can give you valuable information about user reaction 
and interaction. You should make sure the focus groups you assemble represent 
the target demographic you intended when you originally designed you website. 
 
Files Panel  
The Files panel can be used to manage website assets on your hard drive, and 
an externally hosted server, allowing you to re-name, move or delete files. 
Dreamweaver informs you if an asset change requires a link update.  
 
Managing files in the Files panel is easy. Begin by selecting the Panel options 
menu, or by right-clicking a file. When you use the Panel options menu, you can 
use the move, delete and re-name options by choosing File. When you use the 
right–click menu, go to Edit to delete and rename files.   
 
Dreamweaver allows you to connect to a remote folder—just specify the folder in 
the Server category of the Site Definition dialog box.  The remote folder (aka 
the host directory), should match the local root folder of your Dreamweaver site.  
File-transfer-protocol or FTP, is the default option in the Connect Using pop-up 
menu for transferring files to a remote folder. Click Local/Network on the 
Connect Using pop-up to connect to a local or network connection.  
 
When you upload files in your local root folder to a remote or hosted folder, you 
are “publishing”.  
 
To publish your files to a remote folder use the Put command. Before using the 



Put command you should select the local root folder in the Files panel; this will 
upload the entire local root folder. To select only single pages or folders, select 
the file or folder and click the Put button, and the items you selected will upload. 
 
The Get command is used to download files from a remote folder to a local root 
folder. Select the Check Out command to ensure that more than one person 
does not work on a file at the same time. Dreamweaver will let other users know 
that the file has been checked out and by whom when you use the Check Out 
command. If using the Check Out command, you need to make sure the file is 
placed back in the remote folder using the Check In command. 
 
You can also use the files panel to review the site map. 
 
The Related File Tool Bar 
Dreamweaver allows a user to view and edit related files, without losing focus on 
the main documents.  There are two ways to open a related file from the Related 
Files toolbar: 
 
1 - Click the filename of the related file you want to open 
2 - Right-click the related file and select Open as Separate File from the 
context menu.  
 
When you open the related file as a separate file, the main document is not 
visible. 
 
 
 
  


